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Overview 
MIMIC is distributed as a compressed file for each of the platforms referred to in this manual. 
MIMIC is available on a CD-ROM or by a download from the Web. In either case, it is 
necessary to uncompress the file and extract its contents onto your system. 

 

You only need to download MIMIC when a new release is issued; the retail version of MIMIC is 
identical to the evaluation version except for the license keys. Permanent license keys are 
included with your purchase. 

 

If MIMIC is already installed, determine the version you are running by looking at the 
Help>About menu in MIMICView or at the contents of the config/version file. Download 
MIMIC again only if a newer version is available. If you are upgrading from an older release, 
terminate from MIMIC before running the install program. Uninstalling the older release is not 
necessary, since this will provide a backup in case of problems with the newer release. 

 

To terminate from MIMIC: 

1. Click on File. 

2. Click on Terminate.   

Please review the MIMIC Frequently Asked Questions page after having installed MIMIC. 
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Preparing for Installation 

Windows Platforms 
MIMIC supports the following Windows platforms: 

 Windows Vista Business Edition 
 Windows Server 2008 
 Windows 7 
 Windows Server 2012 
 Windows 8 
 Windows 10 
 Windows Server 2016 Standard 

It is highly recommended to install the latest service pack for the respective OS. This section 
describes requirements for the Windows platforms. Later in this section, common problems 
encountered while running MIMIC on Windows are discussed, along with their related fixes.  

 

Administrator Privileges 

For Windows Vista, Server 2008, Windows 7 and newer, please refer to the section “Windows 
Vista and Server 2008”. 

 

 

Firewalls 

Due to pervasive security attacks against Windows systems connected to the Internet, it has 
become common to run a software firewall on recent versions of Windows. 

MIMIC will coexist with a software firewall, provided that the firewall is configured to 
recognize MIMIC as a program allowed to access the network. MIMIC will, due to its very 
nature of simulating networked components, open network sockets and communicate with 
external applications (eg. network management applications, telnet clients, etc). 

 

There are certain components of MIMIC that will access the Internet (eg. specific web sites to 
determine software updates, etc), but only if explicitly configured by the user. 
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Assigning IP Addresses 

MIMIC requires at least one operational network interface card (NIC). On Windows Vista or 
later, as on the Unix platforms, MIMIC dynamically assigns IP addresses when starting each 
agent instance.  

 

5000 / 10000 agent support 

Different versions of Windows have performance limitations while running large numbers of IP 
addresses. The following are the limits on the different versions of Windows.  

 Windows Vista: 10000 agents;  
 Windows Server 2008: 10000 agents;  
 Windows 7: 10000 agents;  
 Windows Server 2012: 30000 agents; 
 Windows 8: 30000 agents; 
 Windows 10: 30000 agents; 

In empirical tests, going beyond those limits introduced non-deterministic instability and 
performance problems.  

20000 / 30000 agent support 

You can run 20000 agents only on Windows Server 2003, and 30000 agents only on Windows 
Server 2012, Windows 8 or Windows 10, and then only with 64-bit executables, and more on the 
Unix platforms..  

 

Virtual Memory 

MIMIC is a specially memory-intensive application, and it needs plenty of physical memory 
(RAM) and virtual memory (swap space) for the more complex device simulations. We 
recommend an absolute minimum 64MB of RAM and 128MB of swap space to start. Verify that 
you have enough swap space in the System Control Panel.  

You should, as a rule of thumb have twice the swap space as your physical memory.  

Different versions of Windows on Intel systems impose different limits on the amount of virtual 
memory accessible for the MIMIC Simulator, but currently the absolute limit is below four (4) 
GB due to 32-bit addressing limitations, which the 64-bit architecture does not have.  

On all versions of Windows there is a 2 GB limit on per-process virtual memory. 

On all 32-bit versions of Windows there is a 2 GB limit on per-process virtual memory. 
 



 

 

MIMIC Installation GUIDE Page 7   

Installation  

On Windows Vista and later Microsoft has removed the boot.ini file and provided the BCDEdit 
command to enable 3 GB addressing as documented in Microsoft’s document.  

To enable this expanded capability on Windows Vista and later, as an Administrator in a 
Command Prompt window, type the command:  

BCDEdit /set IncreaseUserVA 3072  

And then restart your computer.  

This will make "a full 3 GB of virtual address space available to applications and reduces the 
amount available to the system to 1 GB."  

Duplicate IP Address 

For Windows Vista, Server 2008 and Windows 7, please refer to the section “Windows Vista 
and Server 2008”. 

If Windows detects that an IP address on one of its Network Interface Cards (NICs) conflicts 
with another system (resulting in a duplicate IP address), then it tries to resolve this problem by 
shutting down the NIC and displays a message such as: 

The System has detected an IP address conflict with another system on the network. The local 
interface has been disabled. More details are available in the system event log. Consult your 
network administrator to resolve the conflict. 

 

You must not have duplicate IP addresses on a connected network, neither with MIMIC or 
otherwise.  

NOTE: you can disable duplicate IP address detection by following the instructions in the article 
in the Microsoft Knowledge Base titled How to Disable the Gratuitous ARP Function. It is 
appended here:  

How to Disable the Gratuitous ARP Function 
 
View products that this article applies to. 
 
Article ID : 219374 
Last Review : February 24, 2007 
Revision : 3.2 
This article was previously published under Q219374 
 
SYMPTOMS 
 
When a Windows NT-based computer starts, a packet is broadcast on the 
network containing the computer's TCP/IP address to prevent the use of 
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duplicate addresses on the same network. This is called a gratuitous 
Address Resolution Protocol (ARP) packet. Routers and other network 
hardware may cache routing information gained from multiple gratuitous ARP 
packets. For both performance and maintenance reasons, it is possible to 
disable this feature in Windows NT. 
 
RESOLUTION 
 
To resolve this problem, obtain the latest service pack for Windows 
NT 4.0. For additional information, click the following article number to 
view the article in the Microsoft Knowledge Base: 152734 
(http://support.microsoft.com/kb/152734/EN-US/) How to Obtain the Latest 
Windows NT 4.0 Service Pack 
 
STATUS 
 
Microsoft has confirmed that this is a problem in the Microsoft products 
that are listed at the beginning of this article. This problem was first 
corrected in Windows NT 4.0 Service Pack 5. 
 
MORE INFORMATION 
 
To disable gratuitous ARPs after applying this hotfix: 
 
1. Click Start, click Run, type regedt32, and then click OK. 
2. On the Windows menu, click HKEY_LOCAL_ MACHINE on Local Machine. 
3. Click the \System\CurrentControlSet\Services\TcpIp\Parameters folder. 
4. Double-click the ArpRetryCount value, type 0, (for Windows XP, type 1) 
and then click OK. 
5. Quit Registry Editor, and then restart the computer. 
 
 

Media Sense on Windows Vista and newer 

Newer versions of Windows (Windows Vista onwards) have a TCP/IP feature whereby it can 
sense if a NIC is actually connected to the network. By default, a NIC is disabled if it is not 
found to be on the network, which prevents agents from starting in MIMIC. There is a way to 
disable this behavior so that you can work on standalone Windows machines. Attached is the 
Microsoft KB article on this topic. Please remember to make a copy of your registry before 
making any changes just to be on the safe side.  

 

NOTE Windows Vista and newer have no way to disable this feature. You can only run MIMIC 
on Windows Vista and newer with the system connected to a network. 

 
How to Disable Media Sense for TCP/IP in Windows 
 
SUMMARY 
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On a Windows-based computer that uses TCP/IP, you can use the Media 
Sensing feature to detect whether the network media are in a link state. 
Ethernet network adapters and hubs typically have a "link" light that 
indicates the connection status. This status is the same condition that 
Windows interprets as a link state. Whenever Windows detects a "down" state, 
it removes the bound protocols from that adapter until it is detected as "up" 
again. Sometimes, you may not want the network adapter to detect this state. 
You can set this configuration by modifying the registry. 
 
Let me fix it myself 
Important - This section, method, or task contains steps that tell you how to 
modify the registry. However, serious problems might occur if you modify the 
registry incorrectly. Therefore, make sure that you follow these steps 
carefully. For added protection, back up the registry before you modify it. 
Then, you can restore the registry if a problem occurs. For more information 
about how to back up and restore the registry, click the following article 
number to view the article in the Microsoft Knowledge Base: 322756 How to 
back up and restore the registry in Windows 
 
To prevent the network adapter from detecting a link state, follow these 
steps: 
 
Note The NetBEUI protocol and the IPX protocol do not support Media Sensing. 
 
  Start Registry Editor. 
 
  Locate the following registry subkey: 
  HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\Tcpip\Parameters 
 
  Add the following registry entry to the 
  Parameters 
  subkey: 
  Name: DisableDHCPMediaSense 
  Data type: REG_DWORD (Boolean) 
  Value: 1 
  Note: This entry controls the behavior of Media Sensing. By default, 
  Media Sensing events trigger a DHCP client to take an action. For 
  example, when a connect event occurs, the client tries to obtain a 
  lease. When a disconnect event occurs, the client may invalidate the 
  interface and routes. If you set this value data to 1, DHCP clients 
  and non-DHCP clients ignore Media Sensing events. 
 
  Restart the computer. 

 
 
 

IPv6 Support 

IPv6 is supported only on Windows Vista and newer. This is an OS platform limitation.  
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IPv6 is installed as detailed at the Microsoft support website. IPv6 addresses use an additional 
Scope ID as detailed on the Microsoft website. 

If the IPv6 module gets corrupted, you can fix this with this command from the COMMAND 
prompt: 
netsh interface ipv6 reset 

 

NOTE: check the Known Problems section for limitations. 

 

Performance impact of Windows services 

Running unnecessary Windows services impacts performance adversely on a MIMIC system. 
The observed impact has been an approximate 300% slowdown in starting and 1000+% 
slowdown stopping agents, and a 10-20% slowdown in servicing requests. This is documented in 
a Microsoft support page titled "Memory Usage by the Lsass.exe Process on domain controllers 
that are running Windows Server 2003 or ...". The executables running the services end up 
hogging the CPU. This can easily be seen in a process listing in the Windows Task Manager. 

Thus if you are running large lab configurations, we recommend to stop the following 
unnecessary services in the Services Control Panel: 
Display Name          Service Name      Path to executable 

------------------------------------------------------------------- 

IPSEC Services        PolicyAgent       WINDOWS\system32\lsass.exe 

Protected Storage     ProtectedStorage  WINDOWS\system32\lsass.exe 

Print Spooler         Spooler           WINDOWS\system32\spoolsv.exe 

DHCP Client           Dhcp              WINDOWS\system32\svchost.exe -k NetworkService 

DNS Client            Dnscache          WINDOWS\system32\svchost.exe -k NetworkService 

TCP/IP NetBIOS Helper LmHost            WINDOWS\system32\svchost.exe -k LocalService 

Windows Time          W32Time           WINDOWS\system32\svchost.exe -k netsvcs 

Additionally, on Windows Server 2003 we have seen the RPC service hog the CPU while 
MIMIC is busy servicing SNMP requests. On Windows XP SP2 we have seen the RPC service 
crash when stress testing MIMIC, thus rebooting the system by default. We recommend stopping 
all svchost.exe processes, and make sure that the services are configured not to restart or reboot 
the system. 

 

64-bit Support 

The optional 64-bit MIMIC simulator and protocol module shared libraries can run on a x64 or 
AMD64 processor. To do so, you need to run a 64-bit version of Windows , and use Update 
Wizard to download the optional update package with the MIMIC 64-bit executables. 
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Windows Vista and newer 

1. User Account Control 

Windows Vista and later has the new User Account Control feature, which impacts the running 
of MIMIC. For details, consult this Analysis of the Windows Vista Security Model from 
Symantec. In order to enable to run MIMIC on Vista and later, you have 2 options:  

 Disable User Account Control  

This turns UAC off globally. NOTE: do this only if you are aware of the implications of 
this action.  

 On Windows 7: 

 Open User Accounts via Start->Control Panel->User Accounts->User 
AccountsUser Account Control settings.  

Slide scrollbar to bottom (Never notify)..  

 On Windows Vista and Server 2008:  

Open User Accounts via Start->Control Panel->User Accounts->User Accounts. 

Click on Turn User Account Control on or off  

Clear the checkbox for Use User Account Control (UAC) to help protect 
your computer.  

 Click Ok  

 A dialog will popup prompting you to Restart Now or Restart Later. Choose 
appropriately. User Account Control will be disabled once the system reboots.  

 On Windows Server 2012: 

     Follow directions at this Microsoft article. 

 

 Run MIMIC with User Account Control enabled  

This involves changing the access control level of the MIMIC programs.  

o Change the privilege level of MimicView application in the Mimic Start Program 
group using the following steps:  

 Click Start->All Programs->Mimic Simulator x.xx  

 Move the cursor to the MimicView entry  

 Right click and select Properties.  

 In the Compatibility tab, check Run this program as an administrator  



 

 

MIMIC Installation GUIDE Page 12   

Installation  

 Once this is done, MimicView can be started as above or by running the 
MimicView.bat script in the bin folder of the MIMIC installation.  

o If MimicD.exe will be run directly, set the privilege level of it using the following 
steps:  

 In Windows Explorer, select it.  

 Right click and select Properties.  

 In the Compatibility tab, check Run this program as an administrator  

2. Duplicate Address Detection 

On Windows Vista and later, the new TCP/IP stack tries to do "duplicate address detection" by 
default. This prevents MIMIC from starting agents, because IP aliasing is delayed, and even with 
a workaround in our software would unacceptably slow down the starting of agents. To correctly 
workaround the problem, you need to disable "duplicate address detection" for the network 
interface using the Windows netsh utility:  

netsh interface ipv4 set interface "name or index" dadtransmits=0  

The interface name and index info can be obtained by  

netsh interface ipv4 show interfaces    

For example:  
H:\>netsh interface ipv4 show interfaces 
 
Idx  Met   MTU   State            Name 
---  ---  -----  -----------      ------------------- 
  1   50   4294967295 connected   Loopback Pseudo-Interface 1 
  7   20   1500 connected         Local Area Connection 
 
H:\>netsh interface ipv4 set interface "7" dadtransmits=0 

3. Services 

Windows Vista and later has the problem of services interfering with MIMIC operation as 
documented above.  

Here is the list of already documented services and their paths:  
Display Name         Service Name        Path to executable 
----------------------------------------------------------------------------------------- 
IPsec Policy Agent    PolicyAgent       WINDOWS\system32\svchost.exe -k  
                                        NetworkServiceNetworkRestricted 
 
Protected Storage     ProtectedStorage  WINDOWS\system32\lsass.exe 
 
Print Spooler         Spooler           WINDOWS\system32\spoolsv.exe 
 



 

 

MIMIC Installation GUIDE Page 13   

Installation  

DHCP Client           Dhcp              WINDOWS\system32\svchost.exe -k  
                                        NetworkServiceNetworkRestricted 
 
DNS Client            Dnscache          WINDOWS\system32\svchost.exe -k NetworkService 
TCP/IP NetBios Helper lmhosts           WINDOWS\system32\svchost.exe –k  
 
                                        NetworkServiceNetworkRestricted 
Windows Time          W32Time           WINDOWS\system32\svchost.exe -k LocalService 
 

Additionally, these new services in Windows Vista and later MUST be disabled for reasonable 
start/stop performance.  

Display Name         Service Name        Path to executable 
----------------------------------------------------------------------------------------- 
Function Discovery    FDResPub          WINDOWS\system32\svchost.exe –k LocalService 
Resource Publication        
 
IKE and AuthIP Keying IKEEXT            WINDOWS\system32\svchost.exe –k netsvcs 
Modules                                  
 
Network List Service  netprofm          WINDOWS\system32\svchost.exe –k LocalService 
 
Network Location      NlaSvc            WINDOWS\system32\svchost.exe -k NetworkService   
Awareness                                
 
SSDP Discovery        SSDPSRV           WINDOWS\system32\svchost.exe -k LocalService 
 
UPnP Device Host      upnphost          WINDOWS\system32\svchost.exe -k LocalService 
 
Windows Remot        WinRM             WINDOWS\system32\svchost.exe -k NetworkService 
Management (WS-Management)           
 

These are new services that may be disabled for better start/stop performance on Windows Vista 
and later.  

Display Name         Service Name      Path to executable 
----------------------------------------------------------------------------------------- 
Background Intelligent BITS              WINDOWS\system32\svchost.exe -k netsvcs 
 
Transfer Service               
IP Helper              iphlpsvc          WINDOWS\system32\svchost.exe –k netsvcs 
 

Service Details 

 Function Discovery Resource Publication  

Used for publishing network resources. Stopping will prevent other computers from 
discovering the network resources. Will impact applications that work with Network 
Connected Devices, Plug-n-Play Extensions and Web Services on Devices.  

 IKE and AuthIP Keying Modules  

Internet Key Exchange (IKE) and Authenticated Internet Protocol (AuthIP) keying 
modules are used for authentication and key exchange in IPSec. Stopping them will 
prevent IPSec from working.  
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 Network List Service  

Used to determine the networks to which the system is connected, collect/store their 
properties and notify applications.  

Stopping this will prevent the Network Status tray icon from working properly.  

 Network Location Awareness  

Used to collect/store network configuration information and notify applications.  

Stopping this will prevent any applications (like Network List Service) that depend on 
this data from working.  

 SSDP Discovery  

Used to provide Simple Service Discovery Protocol based services. Stopping this will 
prevent UPnP from working.  

 UPnP Device Host  

Used to provide Universal Plug-n-Play services. Stopping this will prevent UPnP 
based devices from working.  

 Windows Remote Management (WS-Management)  

Used for Web Services for Management funcationality. Stopping will disable Windows 
Remote Management and WS Management  

4. Vista Power Management 

The default power options will put the Windows Vista system to sleep after 1 hour of inactivity. 
To disable this, perform the following:  

Open Power Options using Control Panel->System and Maintenance->Power Options.  

Change Preferred Plan from Balanced to High Performance.  

Verify by clicking on Change Plan Settings for High Performance. Ensure that Put the 
computer to sleep setting is Never.  

5. Program Compatibility Assistant 

After the install is completed or aborted, the Program Compatibility Assistant may prompt with 
the message  
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This program might not have installed correctly. 

Please select This program installed correctly if the install completed. Else, select 
Cancel.  

Debugging 

Prior to Windows Vista, crashes can be analyzed post-mortem using the Dr. Watson's crash 
dumps. This requires that Dr. Watson be enabled to handle any application exceptions on the 
system.  

To install Dr. Watson as the default exception handler:  

Click Start->Run.  

Type drwtsn32 -i  

Click Ok.  

A subsequent crash should popup the Dr. Watson dialog. Search for the following files in the 
Windows directory (this location can be changed using the Dr. Watson GUI): drwtsn32.log and 
user.dmp . Send these to Gambit Technical Support (support@gambitcomm.com).  

On Windows Vista and later, by default the Problem Reports and Solutions feature handles 
program crashes. Crash information, including minidumps when available, is automatically sent 
to Microsoft. 

You can check if a MIMIC program crashed and if minidumps are available. Please use the 
following steps to extract any available MIMIC program crash data and forward it to Gambit 
Technical Support ( support@gambitcomm.com).  

 Go to Problem Reports and Solutions using Control Panel->System and 
Maintenance->Problem Reports and Solutions or using Control Panel->Problem 
Reports and Solutions  

 Click on View problem history  
 Find MIMIC programs in the list  
 Double click on an entry to view the problem details  
 If there is a Files that help describe the problem section, click on the View a 

temporary copy of these files link below that section  
 The files will be extracted into a temporary directory and an Explorer window will be 

opened to view them  
 Forward these to Gambit Technical Support  

If the Problem Reports and Solutions settings are changed to check with the user 
before sending the crash information to Microsoft, Windows Vista will prompt the 
user when a program crash occurs. If you choose Close the program, no additional details are 
generated. If you choose Check online for a solution and close the program, crash 
data may be saved.  
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Microsoft's Debug Diagnostic Tool version 1.1 onwards may be used on Windows Vista and 
later to handle program crashes. If this is installed, please use the following steps to generate 
crash data.  

 Open Debug Diagnostic Tool  
 Click on the Rules tab  
 Click on Add Rule button  
 In the Select Rule Type dialog, choose Crash and click on Next  
 In the Select Target Type dialog, choose A specific process and click on Next  
 In the Select Target dialog, browse the process list, select MimicD.exe and click on 

Next  
 In the Advanced Configurations (Optional) dialog, change the number of 

userdumps as needed and click on Next  
 In the Select Dump Location and Rule Name (Optional) dialog, change the path 

and name as needed and click on Next  
 In the Rule Completed dialog, choose Activate the rule now and click on Finish  

When a crash occurs, the Rules tab in Debug Diagnostic Tool will show the userdump count. 
Forward the available files from the configured dump location to Gambit Technical Support.  

 

Known Problems 

Gambit is constantly improving MIMIC’s performance. The following problems while running 
MIMIC on a Windows platform have been identified:  

 On Windows Vista and newer you cannot run MIMIC on a standalone PC (not connected to 
a network). This is due to the OS having removed the ability to disable media sense. We 
have found no workaround for this limitation. 

 Windows NT — if the host is using DHCP to obtain its address, no agent instance can use 
that same address to export a MIB. The problem is that on stopping the agent this address is 
deleted which shuts off the TCP/IP services (ftp/telnet/internet). To restore working you 
either need to REBOOT or start the agent on the DHCP assigned address again (keep it 
running). 

 On Windows Vista you can only configure upto 10000 agents and 15000 +/- IP addresses.  
On Windows Server 2008 you can only configure upto 10000 agents and 12000 +/- IP 
addresses.  
On Windows 7 you can only configure upto 10000 agents and 11000 +/- IP addresses.  
Any subnets can be used for these addresses.  

 On all versions of Windows you can only run up to 64 MIMIC clients over the local 
management channel. [bug 2371]. The Unix versions of MIMIC have no such limitations on 
the number of clients.  
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 On Windows, certain network interface cards have limitations supporting multiple IP 
addresses. In particular, some adapters and/or drivers from 3com have been giving us trouble 
(e.g. 3C905-TX or 3Com 3C90x Ethernet Adapter). The symptom is that a small number of 
agent instances can be started and polled correctly, but connectivity is lost to the box when 
starting more.  

 On Windows, certain software is incompatible with MIMIC. In particular, if Novell Client is 
running, your machine may hang after starting and stopping a small number of agents (the 
System task will use 99+% of CPU). Just unchecking the box in Local Area Connection 
Properties is not sufficient - you have to uninstall it.  

This problem is unrelated to MIMIC. Any test program (e.g. ifdiag shipped with MIMIC) 
which uses the Windows API to register/unregister network addresses will reproduce the 
problem.  

 If you want to run MIMIC inside virtual machine software such as VMWare, please contact 
Gambit Communications Technical Support (support@gambitcomm.com). 

 MAC Bridge Miniport in Windows Vista and later is not supported. To remove the 
adapters from the network bridge, follow the instructions at this 
(http://support.microsoft.com/default.aspx?scid=kb;en-us;824922) Microsoft support page. 

 IPv6 will only work on Windows Vista or later. It runs on all supported versions of Unix. 

When adding or deleting IPv6 aliases to/from an agent it can take 2 to 3 seconds for the 
operation to complete per agent. This slowness is caused by the Domain Name System 
(DNS) performing a lookup to see if the address is actually a registered domain name. To 
resolve this problem you must follow both the steps listed below: 

 Do not use domain names and only use IPv4 or IPv6 addresses for all agents. 

 Do either of the following: 

 add the line "hostname_resolve = 0" to your mimicd.cfg file in your MIMIC config/ 
directory; 

 set the environment variable "MIMIC_HOSTNAME_RESOLVE=0" on your 
Windows system.  

Even with this workaround, adding and deleting IPv6 aliases is approximately 5 to 10 times 
slower than on Linux or Solaris. If you are running thousands of agents, your performance 
will suffer. 

Furthermore, our testing uncovered that the Microsoft netsh utility used to add aliases 
sometimes fails silently. There is no workaround, until Microsoft publishes an API. 

 On Windows you cannot add IPv6 addresses on disconnected NICs, contrary to IPv4, where 
there is no problem. This is an OS limitation that we cannot overcome. There is no such 
limitation on other OS platforms. 
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 On Windows 8.1 adding large numbers of IPv6 addresses crashes the Windows Explorer due 
to STACK_OVERFLOW. MIMIC continues to run correctly. Windows quickly recovers 
with no apparent harm, since Windows Explorer automatically restarts. This is reproducible 
with the Windows netsh tool, thus is a limitation outside of MIMIC. 

 Performance on Windows Vista is much worse than Windows 7 or later, specially with large 
scenarios. For this reason, we DO NOT recommend running MIMIC on Windows Vista.  

 On all versions of Windows, there is a configurable limit on per-process "USER objects". 
The default limit of 10000 interferes with MIMICView for large-scale simulations. Eg. if you 
want to display a large number of device types (more than 1000) with Simulation-
>Devices, the display may hang and leave droppings on the screen, in particular a line of text 
at the top of the display.  

To work around this limitation, you have to increase the number of USER objects as 
described in this Microsoft support page . The absolute limit is 18000, which you will NOT 
be able to overcome. With this limit, you'll be able to display about 2000 average-sized 
devices.  

In addition, there is a limit on the "desktop heap", as detailed in this Microsoft support page . 
Change this parameter in the registry to overcome heap limitations.  

MIMIC on other platforms has no such limitation. 

 On Windows, the NVidia ForceWare Network Access Manager that is enabled by default 
for NVIDIA nForce Networking Controller cards causes problems when MIMIC is 
starting and stopping agents. The symptoms are that connectivity to the network is disabled. 
The only workaround we have found is to uninstall the program, since disabling it seems to 
have no effect. 

 The native telnet client on Windows has problems as documented in detail in the Virtual Lab 
Windows Installation Instructions. 

In case of difficulties, please contact Gambit Technical Support (support@gambitcomm.com).
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Linux 

MIMIC runs on any version of Linux with a kernel version greater than 2.0, but preferably Red 
Hat Linux Fedora Core 19 or later (kernel version 3.14 or later) or Red Hat Enterprise Linux 7. 
By default it runs on newer versions of Linux (Fedora 15 or later) in 64-bit mode, but we publish 
a legacy release for older versions of Linux and 32-bit mode. 

Although we have reports of MIMIC running on a variety of distributions (such as Debian, 
SuSE, Caldera, etc), the latest release has been tested at Gambit to run out-of-the-box with  

o Fedora 8 through 25  
o Enterprise Linux 7, 9 
o CENTOS 7, 8 

Graphical User Interface 

Even though MIMIC can be run entirely without a graphical user interface (GUI), using a GUI 
initially will speed your tasks significantly. The MIMICview GUI is a X Windows client and 
requires an X server either on the local desktop or remotely.  

To display on Microsoft Windows we have had success with the Cygwin/X or MobaXterm X 
servers, but other implementations like Xming do not work as well. On headless machines you 
can run a RDP implementation such as Xrdp to display on Windows desktops. 

Additionally, any window manager running on the desktop will impact the behavior of the 
MIMICview GUI. For example, keyboard focus is entirely dependent on the window manager. If 
you use keyboard control of MIMICview, the window manager focus policy impacts the 
behavior after dismissing dialogs. 

 

Swap Space 

MIMIC is an especially memory-intensive application, and it needs plenty of RAM and swap 
space for the more complex device simulations. We recommend an absolute minimum 64MB of 
RAM and 128MB of swap space to start. Verify that you have enough swap space with the 
following command from any shell:   

% cat /proc/meminfo  

It should display something like  

% cat /proc/meminfo 
MemTotal:      1000448 kB 
MemFree:         37100 kB 
... 
SwapTotal:     1000448 kB 
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SwapFree:      1000448 kB 
... 
 
 

This system has 1 GB of RAM (MemTotal), and 1 GB of swap space (SwapTotal). You should 
have, generally speaking, twice as much swap space as physical memory.  

If you need more swap space, you can easily create it with the mkswap(8) and swapon(8) 
commands. A 2 GB swap file on the local filesystem can be created with the following 
commands:  

 
# dd if=/dev/zero of=SWAP bs=1M count=2048  
2048+0 records in 
2048+0 records out 
2147483648 bytes (2.1 GB) copied, 63.9475 s, 33.6 MB/s 
 
# mkswap SWAP 
Setting up swapspace version 1, size = 2147483648 bytes 

# swapon [ABSOLUTE-PATH-TO]/SWAP 

Different versions of Linux on Intel systems impose different limits on the amount of virtual 
memory accessible for the MIMIC Simulator. If you run 64-bit Linux the VM limits are of no 
concern, but on 32-bit systems the absolute limit is below 4 GB due to 32-bit addressing 
limitations. We have run MIMIC on common Red Hat distributions with upto approximately 3 
GB of virtual memory. 

 

1000/2000/5000/10000 Agent Support 

You need to perform an extra kernel configuration step on Linux before running MIMIC with a 
large numbers of agents in order to increase the global file descriptor table. We recommend:  
# cat /proc/sys/fs/file-max  

4096  
# echo “8192” > /proc/sys/fs/file-max  
# cat /proc/sys/fs/file-max  
8192  

To apply this parameter permanently, add this command to the boot startup files (e.g., in 
/etc/rc*). Contact your MIS department for more information.  

 

20000/50000/100000 Agent Support 

You can only run 20000 and more agents on 64-bit Linux, and need to apply the appropriate 
configuration step detailed in the previous section. 
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Yellow Pages with large configurations 

If you are running MIMIC on a system that is using Yellow Pages for name resolution, then you 
may encounter the following problem: the Yellow Pages client may lock up if you are running a 
large-scale configuration. The symptoms include delayed command response, error messages in 
the system log of the form ypbind: YPBINDPROC_DOMAIN: Domain not bound.  

This is likely due to ypbind using broadcast to find the Yellow Pages server, as configured in the 
file /etc/yp.conf with this entry  
 domain SOMETHING broadcast 

To solve the problem, comment out the broadcast line and specify an explicit Yellow Pages 
server, with an entry such as  

 ypserver 192.9.200.1 
 
 
 

Performance impact of certain daemons 

Linux is a general-purpose operating system, and as such runs a variety of daemons to provide 
services. Certain daemons interfere with the operation of MIMIC. This is a partial list, if you 
encounter any others, please let us know:  

 avahi-daemon  
The avahi-daemon hogs the CPU for large configurations, because it tries to configure 
DNS entries for the configured IP aliases.  

 NetworkManager 
The NetworkManager hogs the CPU trying to maintain all those IP aliases that get 
created and removed when starting and stopping agents. 

 dnsmasq 
You can stop this since you don't need to run a DNS server. 
 

To diagnose the problem, look at CPU consumption of running processes. To solve the problem, 
stop the daemon.  

 

IPv6 Support  

IPv6 is supported on all Linux platforms that MIMIC runs on. 

Prior to running agents with IPv6 addresses, the loadable IPv6 protocol kernel module needs to 
be installed. This is a boot-time configurable, eg. in 
# ifconfig -a 
eth0      Link encap:Ethernet  HWaddr 00:A0:24:07:C7:8A   
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          inet addr:192.9.200.23  Bcast:192.9.200.255  Mask:255.255.255.0 
          UP BROADCAST RUNNING MULTICAST  MTU:1500  Metric:1 
          RX packets:2740928883 errors:80 dropped:0 overruns:125 frame:80 
          TX packets:2196208374 errors:0 dropped:0 overruns:0 carrier:96 
          collisions:51506073 txqueuelen:100  
          RX bytes:286144626 (272.8 Mb)  TX bytes:1540102588 (1468.7 Mb) 
          Interrupt:10 Base address:0x220  
 
lo        Link encap:Local Loopback   
          inet addr:127.0.0.1  Mask:255.0.0.0 
          UP LOOPBACK RUNNING  MTU:16436  Metric:1 
          RX packets:1836705765 errors:0 dropped:0 overruns:0 frame:0 
          TX packets:1836705765 errors:0 dropped:0 overruns:0 carrier:0 
          collisions:0 txqueuelen:0  
          RX bytes:3869230693 (3689.9 Mb)  TX bytes:3869230693 (3689.9 Mb) 
 
# modprobe ipv6 
# ifconfig -a 
eth0      Link encap:Ethernet  HWaddr 00:A0:24:07:C7:8A   
          inet addr:192.9.200.23  Bcast:192.9.200.255  Mask:255.255.255.0 
          inet6 addr: fe80::2a0:24ff:fe07:c78a/10 Scope:Link 
          UP BROADCAST RUNNING MULTICAST  MTU:1500  Metric:1 
          RX packets:2740929031 errors:80 dropped:0 overruns:125 frame:80 
          TX packets:2196208477 errors:0 dropped:0 overruns:0 carrier:96 
          collisions:51506073 txqueuelen:100  
          RX bytes:286160140 (272.9 Mb)  TX bytes:1540116436 (1468.7 Mb) 
          Interrupt:10 Base address:0x220  
 
lo        Link encap:Local Loopback   
          inet addr:127.0.0.1  Mask:255.0.0.0 
          inet6 addr: ::1/128 Scope:Host 
          UP LOOPBACK RUNNING  MTU:16436  Metric:1 
          RX packets:1836705775 errors:0 dropped:0 overruns:0 frame:0 
          TX packets:1836705775 errors:0 dropped:0 overruns:0 carrier:0 
          collisions:0 txqueuelen:0  
          RX bytes:3869232221 (3689.9 Mb)  TX bytes:3869232221 (3689.9 Mb) 
 
sit0      Link encap:IPv6-in-IPv4   
          NOARP  MTU:1480  Metric:1 
          RX packets:0 errors:0 dropped:0 overruns:0 frame:0 
          TX packets:0 errors:0 dropped:0 overruns:0 carrier:0 
          collisions:0 txqueuelen:0  
          RX bytes:0 (0.0 b)  TX bytes:0 (0.0 b) 
 

When using ping6 to check connectivity to an IPv6 target, for link-local IPv6 destinations you 
must supply the -I option, eg. 
% ping6 -I eth0 fe80::a00:20ff:feb0:2780 
PING fe80::a00:20ff:feb0:2780(fe80::a00:20ff:feb0:2780) from 
fe80::d0:b760:a3f7 eth0: 56 data bytes 
Warning: time of day goes back, taking countermeasures. 
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64 bytes from fe80::a00:20ff:feb0:2780: icmp_seq=0 hops=255 time=4.618 msec 
64 bytes from fe80::a00:20ff:feb0:2780: icmp_seq=1 hops=255 time=244 usec 
64 bytes from fe80::a00:20ff:feb0:2780: icmp_seq=2 hops=255 time=235 usec 
 
--- fe80::a00:20ff:feb0:2780 ping statistics --- 
3 packets transmitted, 3 packets received, 0% packet loss 
round-trip min/avg/max/mdev = 0.235/1.699/4.618/2.064 ms 
 

When using netstat or route to check or configure routing tables, you need to use the -A inet6 
command line option, eg. 
# netstat -A inet6 -r -n 
Kernel IPv6 routing table 
Destination               Next Hop           Flags Metric Ref    Use Iface 
::1/128                   ::                 U     0      404      0 lo 
3ffe::1/128               3ffe::1            UC    0      1        1 eth0 
3ffe:bc0:c56:1::1/128     ::                 U     0      0        0 lo 
3ffe:bc0:c56:1::2/128     ::                 U     0      0        0 lo 
fe80::/10                 ::                 UA    256    0        0 eth0 
ff00::/8                  ::                 UA    256    0        0 eth0 
::/0                      ::                 UDA   256    0        0 eth0 
 
# route add -A inet6 3ffe::/16 eth0 

For more details see Peter Bieringer's Linux IPv6 HOWTO document. 

 

Please check effects of duplicate address detection below. 

 

Core Dumps 

This section only applies to MIMIC before release 9.00.  

The MIMIC Simulator mimicd runs as a setuid-root daemon on Linux. By default, core files are 
not produced if it terminates abnormally. If you see the mimicd crashing, you need to run it as 
root to enable core dumps to help us diagnose the problem: 
su 
export MIMIC_IGNORE_SIGSEGV=1 
ulimit -c unlimited 
./mimicd 
 

File system 

If you are setting up a partition on your hard disk to contain MIMIC data, you will want to 
consider tuning the block and inode allocation of the filesystem. Since MIMIC data typically 
consists of many small files, on Unix filesystems it uses up a filesystem resource called "inodes". 
When these run out, you will get error messages such as "file system full", even though the 
output of df (1) shows plenty of space available.  
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To change the inode allocation from the default for the mkfs (8) utility, use the -b command line 
option to reduce the block-size to 1024 bytes (the smallest possible, since fragments are not 
supported), and the -i command line option to set the bytes-per-inode to 1024 (to allocate the 
maximum number of inodes).  

For details see the mkfs or mke2fs man pages or consult your system administrator. 

In modern Linux systems you can use a loop device to configure a file as a virtual disk to be 
formatted and mounted with the preferred parameters. This is the recommended procedure to 
setup a 10GB filesystem, eg. as root user in /usr/local:  

# pwd 
/usr/local 
 
# dd if=/dev/zero of=mimic.img bs=1MB count=10000 
10000+0 records in 
10000+0 records out 
10000000000 bytes (10 GB) copied, 119.391 s, 83.8 MB/s 
 
# ls -la mimic.img 
-rw-r--r-- 1 root root 10000000000 Mar  7 13:47 mimic.img 
 
# mkfs -t ext3 -b 1024 -i 1024 mimic.img 
mke2fs 1.42.7 (21-Jan-2013) 
mimic.img is not a block special device. 
Proceed anyway? (y,n) y 
Discarding device blocks: done 
Filesystem label= 
OS type: Linux 
Block size=1024 (log=0) 
Fragment size=1024 (log=0) 
Stride=0 blocks, Stripe width=0 blocks 
9762144 inodes, 9765624 blocks 
488243 blocks (5.00%) reserved for the super user 
First data block=1 
Maximum filesystem blocks=76995072 
1194 block groups 
8184 blocks per group, 8184 fragments per group 
8176 inodes per group 
Superblock backups stored on blocks: 
        8185, 24553, 40921, 57289, 73657, 204601, 220969, 401017, 662905, 
        1023001, 1988713, 2807113, 5115001, 5966137 
 
Allocating group tables: done 
Writing inode tables: done 
Creating journal (32768 blocks): done 
Writing superblocks and filesystem accounting information: done 
 
# mount -t auto -o loop /usr/local/mimic.img /usr/local/mimic 
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# df /usr/local/mimic 
Filesystem     1K-blocks  Used Available Use% Mounted on 
/dev/loop2  7289346  3983   6797120   1% /usr/local/mimic 
 

By setting it up as root, the permissions prevent accidental corruption of the mimic.img file.  

If you need to later increase this virtual disk you can use the resize2fs utility, eg. to add 
10GB, first unmount the image, then resize and mount:  

# umount /usr/local/mimic.img 
 
# dd if=/dev/zero bs=1MB of=mimic.img conv=notrunc oflag=append count=10000 
10000+0 records in 
10000+0 records out 
10000000000 bytes (10 GB) copied, 152.072 s, 65.8 MB/s 
 
# e2fsck -f mimic.img 
e2fsck 1.42.9 (28-Dec-2013) 
Pass 1: Checking inodes, blocks, and sizes 
Pass 2: Checking directory structure 
Pass 3: Checking directory connectivity 
Pass 4: Checking reference counts 
Pass 5: Checking group summary information 
mimic.img: 518409/9762144 files (1.3% non-contiguous), 9276883/9765624 blocks 
 
# resize2fs mimic.img 
resize2fs 1.42.9 (28-Dec-2013) 
Resizing the filesystem on mimic.img to 19531248 (1k) blocks. 
The filesystem on mimic.img is now 19531248 blocks long. 
 
# mount -t auto -o loop /usr/local/mimic.img /usr/local/mimic 
 
# df /usr/local/mimic 
Filesystem     1K-blocks  Used Available Use% Mounted on 
/dev/loop2      14613461 6800269   6836706  50% /usr/local/mimic 

 

NFS 

We recommend not running MIMIC on NFS mounted file systems but on a local disk filesystem 
as detailed above. When the simulator accesses persistent storage for its configuration or 
simulation data, NFS could slow things down considerably. 
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Shared libraries 

If you are getting the error error while loading shared libraries while running MIMIC 
on a newer version of Linux, you need to install the compatibility libraries as detailed in the 
Frequently Asked Questions document. 

 

64-bit support 

By default, MIMIC runs in 64-bit mode (and requires 64-bit x86_64 Linux on 64-bit systems) on 
RHEL 7, Fedora 15 or later.  

The optional 32-bit MIMIC simulator and protocol module shared libraries can run on either 
x86_64 or older ix86 processors, Fedora Core 5 or later. On older Linux releases on 64-bit 
processors you need to first install the 32-bit MIMIC release, then use Update Wizard to 
download the optional update package with the 64-bit executables. Once installed, the extra step 
is to manually give the mimicd executable setuid-root permissions and restart MIMIC with 
File->Terminate.  

Bonded Interface 

MIMIC supports NIC bonding in Linux, that is we have tested that agents configured on bonded 
NICs perform correctly, although we have not seem much performance benefit. 

 

 ARP Cache 

The ARP cache on a system resolves IP addresses to MAC addresses. In the case of a large 
number of MIMIC agents, the Linux ARP cache garbage collection mechanism on the system 
running the management application can interfere interoperability with MIMIC, limiting 
performance or even failing. This is the case if the management station and MIMIC system are 
on the same LAN (without routers in between). In the case of intermediate routers, the issue will 
apply to the router connected to the MIMIC system, but usually ARP tables are configured 
adequately on such systems. 

 

The major clue will be kernel messages of the form 
kernel: Neighbour table overflow. 

In this case, you need to configure garbage collection on the other system to allow more ARP 
table entries, eg. as detailed at this page, eg. to allow 100000 entries   

 

echo "100000" > /proc/sys/net/ipv4/neigh/default/gc_thresh3  
echo "100000" > /proc/sys/net/ipv4/neigh/default/gc_thresh2 
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Known Problems 

We are constantly working to remove limitations, but currently we know of the following:  

 Linux kernels up to 2.4.2 have problems dumping core of multi-threaded applications, 
including MIMIC. There is no such limitation on the 2.6.x kernels in Red Hat Linux 9 
and later. 

 Red Hat Linux 6.2 has problems with logging to automounted filesystems. In the default 
configuration, this will impact only the Trap Wizard if your private area is automounted. 
Red Hat Linux versions 7.0 and later have no such problems. 

 If you use non-standard network masks with agents in the same network, stopping the 
agent that was started first will remove all the addresses in the same network. This is a 
limitation only on Linux. 

 You can only start upto 200 agents with IPv6 addresses on Red Hat Linux 9.x . After that, 
the system hangs. There is no such limitation on Fedora Core 3 and later, or Red Hat 
Enterprise Linux 4 or later. 

 As of kernel 2.6.18 there is a hardcoded limit of 4096 IPv6 route entries, which limits the 
number of IPv6 aliases to +/- 4096. This can only be overcome by increasing the number 
of route entries from a root shell. 

 
# sysctl net.ipv6.route.max_size 
net.ipv6.route.max_size = 4096 
# sysctl -w net.ipv6.route.max_size=8192 
net.ipv6.route.max_size = 8192 

 Starting agents with IPv6 addresses on RedHat Linux 9 is slow (approx. 10 agents per 
second) due to default duplicate address detection. There is no such limitation on later 
versions of Red Hat Linux (Fedora or Enterprise).  

In order to disable duplicate address detection, you can change the dad_transmits 
kernel configurable as follows (assuming that eth0 is your network interface):  

# cat /proc/sys/net/ipv6/conf/eth0/dad_transmits 
1 
# echo "0" > /proc/sys/net/ipv6/conf/eth0/dad_transmits 
# cat /proc/sys/net/ipv6/conf/eth0/dad_transmits 
0 
 

Still, while it takes a couple of seconds to start 1000 agents with only IPv4 addresses 
configured on a common PC, it takes on the order of 140 seconds with just one IPv6 alias 



 

 

MIMIC Installation GUIDE Page 28   

Installation  

per agent with dad_transmits set to 0, and on the order of 400 seconds with 
dad_transmits set to 1. Optimistic DAD settings don't seem to help performance.  

On newer Linux versions (Fedora 25 and newer), duplicate address detection can 
interfere with the startup of agents with IPv6 addresses, leading to errors in the MIMIC 
log containing  

      cannot bind receive IP address IPV6-ADDRESS port 161 
      bind: Cannot assign requested address 

for some IPv6 address IPV6-ADDRESS.  

The workaround is to disable duplicate address detection with  

sysctl -w net.ipv6.conf.INTERFACE.dad_transmits=0 
sysctl -w net.ipv6.conf.INTERFACE.accept_dad=0 

for your network interface INTERFACE. Eg. if your network is eth0, you would use  

sysctl -w net.ipv6.conf.eth0.dad_transmits=0 
sysctl -w net.ipv6.conf.eth0.accept_dad=0 

On older Linux releases, although DAD does not make MIMIC fail, it does slows down 
starting many agents. We have sped up agent startup at least a factor of 10 by disabling 
DAD in our tests.  

 

 If you want to run MIMIC inside virtual machine software such as VMWare or Xen, 
please contact Gambit Communications Technical Support (support@gambitcomm.com).   

 On Linux releases older than RHEL 7 or Fedora 15, Linux on AMD64 systems needs 32-
bit compatibility libraries installed for the 32-bit MIMIC executables to run. A tell-tale 
symptom of this problem would be:  

% file mimicd 
mimicd: setuid ELF 32-bit LSB executable, Intel 80386, version 1 
(SYSV), 
for GNU/Linux 2.6.9, dynamically linked (uses shared libs), stripped 
 
% ldd mimicd 
not a dynamic executable 

On Ubuntu, to install these libraries, as root, run  
# apt-get install ia32-libs 
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On Fedora distributions, to install these libraries, as root run 
 
# yum whatprovides /lib/ld-linux.so.2 
Loaded plugins: refresh-packagekit 
Importing additional filelist information 
glibc-2.10.1-2.i686 : The GNU libc libraries 
Repo        : fedora 
Matched from: 
Filename    : /lib/ld-linux.so.2 
... 
 
# yum install glibc-2.10.1-2.i686 
... 

 On Fedora Core 6, Java or Perl MIMIC clients will fail to connect to the local MIMIC 
daemon with an error such as  

   ERROR: socket - cannot connect. localhost, 9797 

The root cause of this problem is that the /etc/hosts file by default defines localhost 
with an IPv6 address ::1. Changing this back to an IPv4 address 127.0.0.1 as it has 
always been, or defining a new entry, will solve this problem. This has been fixed in 
Fedora 7.  

 If you are running intensive TCP performance tests that open/close many connections in 
a short amount of time, then you will run into the well-known TIME_WAIT condition: 
after a while the agents will fail to respond to new connections even though the system 
seems idle. You can verify this condition with 
 
% netstat -a -n | grep TIME_WAIT 

 
and it would list many lines. For the details and solutions, search on the Internet for 
Linux TIME_WAIT, for example this page. 

 Firewalls interfere with the functioning of MIMIC. We have seen all kinds of limitations 
with different firewalls, among them: 

 

 no connectivity to simulated devices due to restrictive filters 

 throttling of rates via Linux Netfilter, resulting in spurious connection drops and 
rejections. This usually results in networking errors all over the system, like 

 
    do_ypcall: clnt_call: RPC: Unable to send; errno = Operation not permitted 
 
    or in /var/log/messages: 
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    Mar 24 15:29:01 dmb kernel: [970079.411385] net_ratelimit: 50 
callbacks suppressed 
    Mar 24 15:29:01 dmb kernel: [970079.411388] nf_conntrack: table full, 
dropping packet 

 

    If you want to diagnose connectivity problems, turn off your firewall first.  

 

 Network interfaces with long labels interfere with MIMIC. If the active network interface 
to be used by MIMIC, eg. as shown with  
 

% ip link show 
1: lo:  mtu 65536 qdisc noqueue state UNKNOWN mode DEFAULT group default  
    link/loopback 00:00:00:00:00:00 brd 00:00:00:00:00:00 
2: eno16780032:  mtu 1500 qdisc pfifo_fast state UP mode DEFAULT group 
default qlen 1000 
    link/ether d4:be:d9:cb:58:9f brd ff:ff:ff:ff:ff:ff 

 
 
% netstat -i 
Kernel Interface table 
Iface  MTU    RX-OK RX-ERR RX-DRP RX-OVR  TX-OK TX-ERR TX-DRP TX-OVR Flg 
lo    65536  1979263      0      0 0    1979263      0      0      0 LRU 
eno16780032 1500  382210306 0 17720 0   542194465    0      0      0 BMRU 
 

(in this case eno16780032) is more than 10 characters long, then it can overflow the 16-
character limit for network interface names for the IP aliases that MIMIC creates, causing 
ERROR messages when agents start.  

This is an OS limit, and the only workaround is to rename your network interface.  
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Step 1: Get the MIMIC distribution 

If you have a CD-ROM, copy the distribution file for your platform from the CD-ROM to a 
temporary directory. Go to Step 2. 

If you do not have a CD-ROM, you can request a download of MIMIC from Gambit 
Communications’ website at www.gambitcomm.com/site/support. The download URL will 
then be e-mailed to you. 

 

Step 2: Uncompress, extract and install the distribution 

Windows 

1. Run the self-extracting mimic_windows.exe from a system with an Administrator account. 
The Welcome screen appears: 
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2. Click on Next. The following screen appears: 

             

 

Continued next page… 
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3. Read the License Agreement, and click I Agree. The next screen will not appear unless you 
accept the License Agreement. Click Next to continue. 

   

                  

 

Continued next page… 
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4. Then following screen appears: 

       

 

Continued next page… 
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5. Click on No if you do not have the necessary license keys, then click Next to continue. The 
following dialog pop-up will provide you with the instructions and information required to 
obtain one.  If you have received a licensing ticket, you can redeem it for a license key 
yourself by providing the HOSTID displayed in this dialog. Otherwise, copy/paste the 
information into an e-mail request to us. 

 

 

 
 

Continued next page… 
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Click on Yes if you have the necessary licenses for MIMIC Simulator. The MIMIC Simulator 
License keys screen appears: 

 

 
 

6. Enter the License Keys. This is best done by using the Windows copy/paste feature. Then 
click Next. 

 

Continued next page… 
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Select a destination folder for your MIMIC Simulator installation: 

 Click on Next to install MIMIC Simulator in the default folder shown next to the Browse 
button; or, 

 Click on Browse and follow the instructions on screen to select a different folder for 
MIMIC Simulator. The following screen appears: 

 

Continued next page… 
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Click OK after slecting the desired folder to install. Then following screen appears: 

 

Continued next page… 
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Click on Next to install MIMIC Simulator. Then following screen appears: 

 

Continued next page… 
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7. You may type a new folder name, or select one from the existing Folders list, or use default 
Folder e.g., MIMIC Simulator 16.00. Click on Next to continue.  

 

Continued next page… 
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8. MIMIC will be installed in the directory selected in Step 6. After copying installation files, 
following screen pops up: 

 

Continued next page… 
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Click on Yes only if you want to set MIMIC administrative settings. Following screen appears: 

Continued next page… 
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9. Click Next to accept default MIMIC Administrative settings or type User and Directory to 
specify different MIMIC Administrative settings and click Next, following screen pops up: 

Continued next page… 
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Continued next page… 
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Continued next page… 
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Select “View MIMIC Online Help” to view MIMIC online documentation after finishing the 
installation. Then MIMIC Installation will complete with following windows: 

 

Continued next page… 
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Continued next page… 
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Solaris and Linux: 

# gunzip -c mimic_platform.tar.gz | tar xf – 

platform is one of the following: 

            solaris  for Solaris/SPARC 

 solaris-i86pc for Solaris/Intel 

 linux  for Linux/Intel  

There should be four files in the directory extracted to: 

 README - further release-specific instructions 
 license.txt - the license agreement 
 install - the installation script 
 mimic.tar - the product 
 tar – tar utility (only on Solaris) 

Below is a sample session for Solaris/SPARC:  

#. /install 

MIMIC Installation 

 

Copyright (c) 1997-2003 Gambit Communications, Inc. 

76 Northeastern Blvd., Suite 30B, Nashua, NH 03062 

email: support@gambitcomm.   

[license agreement]  

Do you agree with these terms and want to proceed? (y/n)[y]: y 

==================================================================== 

Before you start the installation, you need to obtain the evaluation license key for 
MIMIC. Please contact Gambit Communications Technical Support at  

(603) 881-3500 or support@gambitcomm.com 

with your HOSTID S80b5615c 

==================================================================== 

Do you have the license information and want to proceed? (y/n)[y]: y 

Enter the absolute path where you want MIMIC installed [/usr/local/mimic]: 
/path/to/mimic 
MIMIC will be installed in /path/to/mimic 

Checking available disk space... 
Required space = 84264 kb 
Available space = 705688 kb 
You have enough space to install MIMIC. 

Extracting files (this may take a while)... 

Who should own the MIMIC area? 

This should be the user (not root) who will primarily be using the 
MIMIC software. If you just press the Return key, then the area will 
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be owned by “joe_user”. All other users will have mostly read-only 
access to the MIMIC area, ie. they will be able to run simulations, 
but not change them. It is easy to later change permissions to 
allow a group of users to have write access to the MIMIC area. 
Please enter a username [joe_user]: mimic_user 

Please enter the Simulator license key: License_key_for_Simulator 

Please enter the Recorder license key: License_key_for_Recorder 

Please enter the Compiler license key: License_key_for_Compiler 

Cleaning up... 

You can optionally enable access control, if multiple users are 

sharing this MIMIC installation.  If so, you need to first setup 

2 administrative settings: 

- the administrative user is the special user who has exclusive 

  rights to change the Simulator access control database; 

- the administrative directory is where special files like persistent 

  settings and access control database is stored. 

 

Do you want to configure administrative settings? (y/n)[n]: y 

Please enter the administrative user [joe_user]: 

 

Please enter the administrative directory [/path/to/mimic.admin]: 

 

Are you upgrading MIMIC from an earlier version? (y/n)[y]: n 

 

==================================================================== 

Your installation is now complete. 

To start, exit out of the root shell, change directory to 

/path/to/mimic/bin and invoke MIMICView by typing 

./mimicview 

at the shell command prompt. 

 

The online documentation is accessible from within MIMICView with the Help menu or 
with your favorite HTML browser at URL file: /path/to/mimic/help/mimic.htm 

==================================================================== 

You can leave the License_key entries blank if you do not already have a set of license keys.  
The license keys can be copied into the /path-to-mimic/config directory after the installation is 
complete. 

 

Step 3: Additional Support 

If you have any problems or questions, contact Gambit technical support by e-mail 
support@gambitcomm.com or by telephone at (603) 881-3500. 



 

 

MIMIC Installation GUIDE Page 50   

Installation  

Index 
E 

Environment Space (Windows 95) 5 

F 

FAT file systems 5 

I 

Installation procedures 35–52 
IP addresses 

Linux 29, 27, 30 
Solaris 22 
Windows 5 

L 

Linux 
Install MIMIC 28 
Install RedHat 28 
IP addresses 29, 30 
Swap Space 28 

M 

MIMIC 

Installing 35–52 

S 

Service packs (Windows NT) 6 
Solaris 

IP addresses 22 
Port 161 22 
Swap space 21 

T 

Technical support 52 

U 

Uninstall MIMIC 3 

W 

Windows 
FAT file systems 5 
IP addresses 5 
Required privileges 4 
Service pack 3 6 
Sharing with Linux 28 

 

 


